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About Flip PDF Pro

Flip PDF Pro is a much professional program to
help you convert ordinary PDF files into stunning
booklets with amazing page-flipping animations
and sound! Besides original classical Flip PDF
features such as adding background images and
sound, Flip PDF Pro also provides more powerful
and professional functionalities, like embedding
video, audio and links into your flipbook pages,
exporting defined templates and settings to theme
for later easy using, using command line to
automate the creation of the flash eBooks without

opening the Windows desktop application.

Note: This product is distributed on a "Try before-you-buy"
basis. All features described in this documentation are
enabled. The registered version doesn't insert a watermark in

your generated page-flipping eBooks.
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Product features

10.

11.

12.

13.

14.

15.

16.

17.

Convert PDF to Adobe®© Flash® based page-flipping eBooks.

Batch convert multiple PDF files to a single or multiple page-flipping eBooks.

Provide command line version.

Offer Project Panel to easy open or save project.

Import bookmarks (outline) with PDF, and edit them manually.

Import hyperlinks with PDF, include web link, page link, email link.

Import text so text is searchable, define the minimum search characters.

Detect landscape page to present as two-page spread.

Add watermarks text, image, dynamic date/ time etc to page-flipping eBooks.

Define quality and size for normal version and mobile version.

Detect landscape page to present as two-page spread.

Publish online directly with using FlipBuilder Upload Service.

Build digital bookcase to store, manage and sell eBooks.

Output in different formats: HTML, EXE, Zip, Mac App, Mobile version and Burn to CD.
oHTML allows you to upload to a website to be viewed online (with title, keywords and
other metadata defined).

oEXE (with setting title, icon and open window size) and Zip allow you to send to your
user by email to be viewed on their computer.

oApp (Mac Application) is executable application can be run on Mac.

oMobile version is to output HTML flipbook which can be viewed on mobile devices via
Browsers.

oBurn to CD allows you to burn to disk so you can send your user physical media for
viewing on their computer.

Apply a pre-designed template and animated scene, more free templates online.
Show Assistant and scrolling tips in your book, and record or embed sound directly.

Preview the output effect instantly.
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19.

20.

21.

22.

23.

24.

25.

26.

27.

28.

29.

30.

31.

32.

33.

34.

35.

36.

37.

38.

39.

40.

41.

42.

43.

Add Title in Float template which can be clicked to visit webpage online.

Add Image or Flash logo to insert before Book Title in Float template.

Define book proportions, thickness, margin size, shadow manually.

Replace existing icons on toolbar by editing Icon Flash file.

Add new icons into toolbar with calling new actions.

Set background color and image.

Insert background music either for continuous play (loop) or for a set duration.

Set eBook reading from right to left (for Right-to-Left languages such as Arabic).
Choose hard cover for eBooks.

Set fonts for Flash and Bookmark, Search panel.

Set Page Number Box to show at top or bottom in Float, set start page number.

Edit pages with shapes, text, links, images, videos, flash or sound files.

Add Button on pages to open link page, call Javascript action, play Flash/Video in pop-up
Window.

Add page, delete page, re-order and sort page in Page Edit window.

Copy projects from one page to another or all the other pages.

Define the language for your published page-flipping eBook (support multi-language
show and switchable).

Add password to protect your page-flipping eBook.

Different render engine types for special PDF files: SWF, GPL Ghostscript or Inner Library.
Add Google Analytics Support.

Add watermark image or SWF to show on print out pages.

Add Help config to manually define content with using Image or SWF.

Add Single/Double Page view.

Add Minime Style to show page-flipping eBooks without toolbar.

Set permissions for downloading, printing, social sharing, Home, About features, etc.
Edit bookmark manually and set bookmark panel to show on left or right side.

Export and save settings for future uses.
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Page-flipping eBook features

With the page-flipping ebook you have created, your user will be able to:

10.

11.

12.

13.

14.

Flip book pages by dragging corner, clicking page shadow, mouse wheel, etc..

Use Previous, Next, First or Last buttons or thumbnails to navigate through the pages.
View with important pages pre-loaded to open quickly, no need to wait for all pages to
be loaded.

Flip pages automatically.

View page-flipping eBook in full screen.

Add annotation text or shapes to highlight.

Print out the whole eBook or a selected range of pages.

Download uploaded page-flipping eBook or other file while reading book.

Double-click to zoom in or zoom out.

Share eBook URL via email, Facebook, Twitter, Google, Yahoo, etc.

Turn background sound on/off.

Open in the Browser to a specific page by adding a page index to your URL. E.G.

www.yourdomain.com/index.html?pagelndex=4.

Always show in Minime Style with adding a parameter to URL. E.G.
www.yourdomain.com/index.html?alwaysMinimeStyle=true.

View page-flipping eBooks in the browser of Mac, PC, iPad, iPhone and Android devices.
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Quick Start

1. Launch the application via the desktop shortcut ;

Create New

2. Click "Create New" & and select template and define project path;

l Import Now

3. Select PDF to import and click "Import Now" icon to enter into template

setting interface;
4. Define parameters for eBooks, such as Book, Tool Bar, Bookmarks, and then click the

"Apply Change" icon ®;

_._@} Edit Pages

5. Click "Edit Pages" to add objects like links, images, sounds, videos on

pages;

&l upload online

6. Click "Upload Online"! | or "Convert to Flipping Book" E to output

created page-flipping eBook.

Interfaces

There are some main interfaces you will see while using Flip PDF Pro as below
shows: Project Panel, Application Options, Import PDF, Template Settings,
Edit Pages, Language Option, Output, Batch Convert and Upload Online. You

can enter into each page to get clear instructions for every detail option.
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I. Project Panel

™~
w Flip PDF Professional

Recent Projects Create New

g TEST
ﬁ| Project
W demo
ﬁ| Project

E Open...

Create New

Recent Qutputs
I~
B!
[ Desktop -

[ demo
E Open...

BookCase Demo
Shopping Cart Integrated |

Copyright by flipbuilder.com

Online Service
How easily share your books online
Login{Manage your books)

Open BookCase

Support

Contact us
FAQ
About

Check for update

Help document

Home Page

In the project control panel, you can view and open recent projects and output flipbooks, create

new project or just view demo project. Besides, you can view Online Service details, get support,
check "About" and "Update" info.

Il. Import PDF Interface

Chick "Create New" to build your own project, select template, define project name and location.

[l select Template
My Templates | Online Templates |

| Nty dertped Meal Temlate proviles & st aed fes ook for oo lo desige mone stunong jrege-lipsog efocks, T
Neat Template, you can add brand logo in the top toabar, sct ditherent featured buttona, show or hide transparent

at bottom, enable Socal Share via different channels, etc. Neat presentabon interface, neat contral panels and
vl t el mares busks 1o L]y rieal fodivng puble atives,

i My [emplates

[ Crassical

|E Foat
B reat
(R Sl
[ colends

i

|_| Condsenecss
Alack Patterny Dlank

Light Shadow

[ Hewbie
[E] Handy
[E0 vivety

[T sngeside

(irovee) oo |
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You can select Template and Theme from the list, or go to "Online Templates" panel to download
more templates and themes to use in Flip PDF Pro.

More templates and themes online: http://www.flipbuilder.com/templates-themes/index.html .

Then click "Next" to enter into PDF Import interface:

Source PDF File

E:\About mailreceived files\Downloads 2012, pdf Browse., | | Open it
The Page Ranges to Import \Watermark
@ All pages At Place a custom text or image
"I Customrange; 1-10 Example: 1,3,5,9-21 f o Watermark(Stamp) to the file(s)
[T Quickly import {Only import 10 pages to initial preview) Set Watermark |
Page Quality
Quality And Size:  |High quality larae file size b |

M High values produce better page quality but require more disk space and more time to download,
[¥] Import bookmark [T1mport links [T Enable seardch [| Detect wide pages

1. Source PDF File:

Click this icon to open the PDF file you want to convert;

Qpen it View content of added PDF file to clarify before converting.

2. The Page Ranges to Import:

i@
2 All pages Convert all pages to page-flipping eBook;

@ Custo P E le:1,3,5,9-21 )
T S Convert defined range page;

[¥] Quickly import (Only import 10 to initial : '
(| Quickly import (Only impart 10 pages to initial preview) Just preview effect on first 10 pages.

3. Watermark

i
Add image or text watermark to flipping pages.

[¥] applying Watermark . . .
Check this option first to choose default stamps or add new ones:

Copyright 2013 by FlipBuilder.com
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Page-flipping eDook

E Edi /
&  Add fext stamp
= Add image stamp |t Image Watermark
Add Image Watermark
b4 Delete L Fines
| pemes ey Vst
& Move down e
+  Move up | [oercuise
i X ‘
e [
tmage Effect
Qpacty: g%
Rokaton: O o degree

Postoninmarprs  Margrs

mow oW T
. )
[T
1o 3] =
.
e ter

4. Page Quality
There are five types of "Quality And Size":

High quality large file size.
High quality large file size
Medium quality medium file size
Low quality small file size
Lower quality smaller file size

5. Other Options:

Import bookmark

Check this option to use bookmarks of PDF in page-flipping eBook;

S If your PDF file has links, check this to enable in flipbook;

Enable search

Check this option to enable search functionality in created flipbook.

Detect wide pages

two-page spread in output flipbook.

Check the option to make landscape page in PDF file to be presented as

At last, click icon to enter into template setting interface.
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lll. Template Settings Interface

ofessionsl 1 "Demoticw
Convert Qptions Opline Help

II!I. Impart POF i;?'jﬁeitngs @mmm mwnTomumk zuumm

Search: *

Hard Cover Mo -
Flipping Time 0.6
Mouse Wheel to Tumn P... |Yes
ElPage Mumber
Start Page Number (R...|0
Start Page Mumber (A, 3

ElMinime Style w
Use Minime Style ez
Width 400 W ELIPEILILOER COM
Fieght 300
EJFlash Control Settngs
Secusity Satbngs Ho Security

ElLinks

Mouss aver eolor W 0xE00080 Flip POF PRD
Linik alpha 0.2 2

Windaw Blank ’ e
Enable after 2o0ming in |Enable 'I -

Enabile after zooming in
E? | Enabel/ Disable the ki when zoom in

Il LT T Aot g ey

; i
| instant Help 2 Thumbnais 0 Auto Fip o

After importing PDF, you will see the main Template Design and Preview interface. Four tabs
in the design panel for you to design template, choose scene, define bookmark and edit
content for assistant.

r=gn etng] | scenes | soakmark | Assstant | Design settng | === | Bookmark | Assistant | Design serung | scenes [TEFTTY Assictant | | wesen eting | scencs | boslmark| [fo=ianl |
Templates Double cick to apply scenes, You can sctup bookmarks here

=
i ﬂ Neat H B lﬂ_] I e amaE = = | 2 Record & Manage Audio Fikes i:
2 ‘ - Eﬂwnn 1 Double chick to aoply assistant.

Chapter 2
et ” . | g\aums
- Hiowne Ao I ct:;;:—:
[Tool Dar Settings | - E.l i .

Flashi Displey Settings | - Brhsisen —_—

Pagae thickness. Thinner T Saper Nona Ly
Sachirand Mohi — L — el Tites

ReeLiin the buak Lo ceniler (Yes e — = e

il

m

Show Comer Hp Effect | Irue Autumn leaves Deadh beauty Bage: 1
Mouse Tracng Cffect | True -
Unmbnais paliel | Fal : & Input “titde text; 3" drectly n the tle to quick
m' L -] [ "I| - | ]| name booktige as “dtie text" and page as ="
Duttons = t [

1. Design Setting
The design setting interface contains below main parts: Choose Template, Tool Bars
Settings, Flash Display Settings and Flash Control Settings.

(1). Choose Template
Templates

‘ Ifl Neat ‘H A &

More free online templates here. ..

Copyright 2013 by FlipBuilder.com
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Although you have selected template before importing PDF, you can also change to other

!i MNeat E

interface, or download Online Templates to use.

templates. Just click ‘ icon to select templates from Template Selection

Bclick this icon is to save current settings as a TXT file for later uses;

Click this icon is to import stored setting file at once.

There are 4 different templates at present: Classical, Float, Neat and Spread. You can also click
"Online Templates" to install more templates to use. Each template contains some unique
settings. More templates and themes online:
http://www.flipbuilder.com/templates-themes/index.html .

(2). Tool Bar Settings
[ETool Bar Settings il
HTitle Bar
HButtons Bar
Tool Bar on top Falze

_ Add Icons Settings
| EButton Icons

i. Title Bar (only in Float template)

| Eitle Bar |
i The Book Logo C:\Users\Admini... |
| Logo URL http: {fflipbuilder. .. |
i Book Title <a href="http://... |

|

| PageMNumberBoxOn... False

|y FLIPBUILDER.COM |

Customize book title and logo for showing on the top of your flipbook. You are enabled to set the
book title as HTML format text. For example: <a href="http://www.flipbuilder.com'
target='_blank'>FLIPBUILDER.COM</a> | <font color="#ff0000' size='14'>Red Color</font>

ii. Buttons Bar

EButtons Bar
Full Screen Button Show
FHelp Config
FHPrint Config
FHDownload setting
HSound
HZoom Config
HSearch
Hshare
FHLanguage
[ Autao Flip
Add Annotations Enable

Copyright 2013 by FlipBuilder.com
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Home Button

You can add a home buttonn to help reader to click and go to your website directly:

ElHome Button
Home Button Visible Show
Page URL http:/Mipbuil. ..
Open Windaow Blank
About Button

Add About button N\ to show the author, contact, book, company info:

[ Elabout Button
About Button Visible  |Show
Content ::textﬁ:urmatj

Click "..." to enter into "About & Contact" edit interface:

I
| About & Contact Settings
|

Flip PDF Professional DemoBook - & Clear

Presents powerful features in the Flash digital eBook, such as sodial share, print, autoplay

e B save as..
Contact us at: alice @flipbuilder.com e
http:/fflipbuilder.com |33 Load..

S Demo

‘You can use some “tags” to format the text shown in the “About & Contact” window, such as text font, font color,
hyperlinks and =0 on.
Maore details about tags please: Click Here

[ OK ] I Cancel ]

After clicking the About button, you will view the About window by clicking the button:

\c About & Contact

Flip PDF Professional DemoBook

Presents powerful features in the Flash digital eBool, such as social share, print,
autoplay ete.

Contact us at: alice@flipbuilder com

http:/flipbuilder.com

Full Screen Button

To enable "Full Screen" functionality in output flipbook, select "Show" in "Full Screen Button"

option: Full Screen Button Show

[
Then you can click icon - to view flipbook in Full Screen, click icon or "Esc" button

to exit from the Full Screen.

Copyright 2013 by FlipBuilder.com
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Or if you want to show your flipbook without Tool Bar while showing in Full Screen mode, you
can set "No" in "Full Screen without Tool Bar" (just in Classical Template):

Full Screen Without Toaol.. .| Yes

Help Config
HHelp Config
Help Button Show
Help Content File -type.png =)
Help Window Width | 400
Help Window Height 450
Show Help At First Shaow

To show tips about viewing flipbook, you can set "Show" in "Help Button" option, and you can
define Help Content manually by inserting "Help Content File (image or SWF)", also enable to
define the Width and Height of the Help image or swf. If you set "Book->Retain the book to
center->No", you can set "Show Help At First->Show" to display the Help Panel with the Book as

below:
v FigBuidorcom  pages: ([N

Double-click to room infroom out;
Dvag the page corner or
Use mouse wheel ta flip pages.

Help:

You can also click the button to view the same Help page in pop-up window.

Print Config

EIPrint Config
Print Enable fes

Print Wartermark File | FESVEeRage =

Choose "Yes" in "Print Enable", then click icon to set print page range as below:
él Print '

=) Print Al Pages
) Print Current Page
_) Print Range

Example; 2,58-26

&, Print
4

Copyright 2013 by FlipBuilder.com
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You can also click "Print Watermark File->..." button to choose image or SWF file from your

computer as watermark on printed out pages.

Download Setting
ElDownload setting i
Download Enable |'fes |
Download URL SDFDemo. pdf!

If you want your flipbook readers to download the PDF file or the flipbook directly from your
website, select "Yes" in "Download Enable" option, then input the Download URL directly, you
can use absolute path like
"http://www.flipbuilder.com/flip-pdf/example/files/download/FlipPDFDemo.pdf" or relative
path like "/files/download/FlipPDFDemo.pdf" (make sure you have uploaded the PDF to the
same path).

Then readers can click the icon n to download your uploaded PDF file directly.

Sound
Esound |
Enable Sound Enable l
Sound File ol 3.mp 3 |
Sound Loops -1 |

If you want to add background sound to your flipbook, such as a song or other audio file, set
"Enable Sound->Enable", then click " 2=|" icon to choose "Sound File" from your computer, then
set "Sound Loops", "-1" stands for playing the sound file all the time while viewing flipbook,
other value (N>0) stands for the times of playing the sound file.

Zoom Config

EZoom Config
Zoom in enable Yes
Zoom Scale 1.5

To Enable Zoon In functionality, choose "Yes" in "Zoon in enable", then set "Zoom Scale", the
value is the times between zoomed page size and the current page size.

Copyright 2013 by FlipBuilder.com
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In Float template, you don't need to set Zoom Scale, you can adjust more conveniently by the

zoom in tool like this: == You can also set "Scroll with

mouse->Yes" to scroll zoom in page while moving mouse.

Search

Search Button Show
Search Highlight Color [CJoxFFFFa0
Least search characters |3

Select "Show" in "Search Button" (make sure you have check "Enable Search" option in "Import

PDF" interface), then define "Search Highlight Color", after clicking "Search" icon , you

will see a popup box to input search words, then click Enter or "Search" button, you will get the
below searching result:

Share

i' Hshare
| Share Button
I_ Sodal Share Button | Show

You can share via emails, or just through Facebook, Twitter, Google, etc..

a. Share Button
If you want readers to share via Email, you can enable "Share" feature as below shows:
[HShare Button

Share Button Show
Email Subject Rear my fli...
Email Body {ink}

When the viewers click the share button E, they will enter into the Email interface with the

link of your flipbook in the Email body.

b. Social Share
If you want your flipbook viewers to send the link to their friends or clients via Facebook, Twitter,
Linkedin, Google, Yahoo and so on, you can add a Social Share button in your flipbook for readers

to send out your flipbook link immediately:

Copyright 2013 by FlipBuilder.com
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| Social Share Button |Shnw |

The readers just need to click the "Social Share" button ﬁ, then the below window will pop up

for them to choose share channel:
Social Share

Mirrosnft Word - dema3.docy

G Twitler

Googla
Yahoo

F\?A StumbleUpon

4d - Al
m Mixx

+ More

Auto Flip
To auto flip your eBooks, you can set "Yes" in "Auto Flip->Enable" option; then define the Flip
Interval (seconds of staying on each page); the value of "Play Count" stands for the times of auto

playing the eBook, and "-1" stands for playing forever (after clicking the Auto Flip button “,

the flipbooks will be flipped by staying 3 seconds per page); if you want to auto start and flip the
eBook after opening, just set "Auto flip when start up->Yes":

B auto Flip
Enable fes
Flip Interval &
Play Count -1
Auto flip when startup |Yes

Thumbnail Button
| Thumbniail Button |Enable |

Show Thumbnail Button E(set "Enable") to view page thumbnails of your book, or you can

Disable it to hide the button.

Single Page

| Single Page |Enable |

If your book contains landscape pages, or the page content is different to read for the font is too

small, you can set "Single Page->Enable" to enable readers to click "Single Page" icon n to

view pages one after another, then click "Double Page" icon m to back to the normal book

reading mode.

Copyright 2013 by FlipBuilder.com
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Language
E|L.anguage . English
Language EnglishjChinfﬂ
Switchable ['es

You can set language for showing tools or tips in your created flipbook, click "..." to enter into
"Language Settings" interface. You can choose two or more language to use, just check

"Switchable" option, then users can click "Switch Language" button [-_Jto choose their prefer

language for tips (more language setting details you can view in below Language Setting part):

Please select a language below...

English

French

Add Annotations
To help readers take notes on your books while reading, you can set "Add Annotation->Enable".

When readers view your book on computer, they can click "Add Annotation" iconE to add

text note, highlight pages with brush, draw rectangle or ellipse on anywhere of your book pages.
If they open the book next time, they can view the comments, or delete as they want:

Text Hofe
o
r 012/ 11/35 15:15:55
D add text note, highight pages with
& brugh, drarw rectangie or elipse on
| amywherg of ook,
|
T,
a .~ EBA -~V
ek 7
A . =
=) Baider Alhd 100% =
@  Boedor Coke 27FF00 ]
4

9w+ B
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iii. Tool Bar on Top (only in Float template)

If you want to place the toolbar in Float templates on the top of the flash eBook, you can set
"Tool Bar on Top" as "True":

Tool Bar on top [True

iv. Add Icons Settings

If you want to add some other kinds of buttons which the program doesn't provide, you can click
"Add Icons Settings->..." to enter into "lIcons Settings" interface to add new icons on tool bar:

Add Tcons Settings
& lcons Settings ﬁ

Config kons for toolar
,‘*mumf %€ Remove Icon e 4 poen P Movepown

Capto Achon Type ALon Content

I 1con Settings (=X
Add Toon |
[con Fie

Source Fle:  C:'isers\Ackis trater Deskbon ew folder | z _E;;He R

Button Info
Caghon: GoTaoPage G
fenn Button Acton
@ Go o page Cpen a bk Cal Javascript function

Pagelndex: 6

L) Comn | [

Y Go To Page 6

2 7 # - @ a = §# » w

You can define the link action as "Go to page", or open an online webpage, or even "Call
Javascript function" to carry out your wanted interactive functionalities via defining Javascript
function yourself.. After your "Apply Change", the new added icon will show in the toolbar. (More
details about Call Javascript function will be introduced in the part of "Edit Page->Add Link".)

v. Button Icons

Define settings for the icons of the buttons:

ElButton Icons |
Icon Color | Do e
Icons File(SWF Only)

Copyright 2013 by FlipBuilder.com
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Icon Color
Icon Calor [ |
7T QA T
Icon File

Select the Tool Bar Button to replace with your own icon.

[ Icons File(SWF Orlly) [c:iUsers.. |

More details please view here:
http://www.flipbuilder.com/support/how-to-replace-icons-on-flash-toolbar.htm

(3)- Flash Display Settings

EIFlash Display Settings
Retain the book to center |Yes
EHFont
Initial Show Mone
Show Corner Flip Effect  |False
HBackground Config
Flash Window Color oxafatab
Page Background Color | [CJ0xfFFFFF
HBook Proportions
[#Eook Margins
HPage Shadow
Hide Book Frame Bar Mo
Right To Left Mo
Hard Cover Mo
Flipping Time 0.6
HPage Number

HMinime Style

i. Retain the book to center
| Retsin the book to center [Yes |

Place your book to center or right side based on your needs. For example, if you want to show

background image with advertisement or logo on left side, you can select "No" in the option.

ii. Pages per thickness (only in Neat template)

To create more real life like ebook, you can set Pages thickness, there are 5 levels for you to

choose based on your needs. And on the book edge, you will see different page number tips for

you to click and go to that page directly:

“ G MAEDEPHELT?O
= -—

ste resl Mppieg et Beok i

Copyright 2013 by FlipBuilder.com
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iii. Background Alpha

Background Alpha 1] |
Set the value (0-1) of alpha to control the transparence of the background in flip book. For
example, you can set the value as 0 to make the book background as transparent completely,
when you embed the book in other HTML page, it will show the background of that HTML only.

iv. Show Corner Flip Effect
Show the Corner Flip Effect at the beginning to tell readers that they can drag or click the corner

to turn pages directly.

Show Corner Flip Effect  |True

v. Mouse Tracing Effect

Show Mouse Tracing Effect at the beginning to tell readers that they can drag or click the corner
to turn page. If the book is set to open with double page spread, then the Mouse Tracing Effect
won't work.

Mouse Tradng Effect True

vi. Open thumbnails pallet
Define whether the thumbnail pallet open or not when you arrive on the book.

Copyright 2013 by FlipBuilder.com
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COpen thumbnails pallet  [True

vii. Font

HFant
BlButtons |
Font Color | L0 fFEFF
Button Font | Tahoma
HTitle and Windows
EHBookmark
Hs5earch

Change fonts of toolbar buttons, flash windows even bookmarks or search result panel.

viii. Initial Show (set in Float/ Spread templates)
You can show Bookmark panel or Thumbnails panel on the flash page at the beginning, just select

"Bookmark" or "Thumbnails" in this option:

. Initial Sh Thumbnails *
For Example, select "Thumbna|ls":] i e |

Then you will get flipbook shown with below initial interface:
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ix. Background Config

Background Color:
BlBackgroundConfig | |
_ ElBadgroundColor |
.. GradentColor A |[JOAFFFFFF
. GradientColor8 | MM0x000000
Gradient Anale 1)

Gradient Color A
-~

Gradient Color B

Define background for your flipbook with gradient color or pure color (the same color for
"Gradient Color A" and "Gradient Color B"). Gradient Angle is the angle between two colors.

Background Image (set in Classical and Spread templates):

EBackground Image
Image File
Imaqge position

Click the icon " =" to choose background image from your computer, and there are 11 kinds of
"Image Position" for you to choose: Scale to fit, Fill, Top Left, Top Center, Top Right, Middle Left,
Middle Center, Middle Right, Bottom Left, Bottom Center and Bottom Right.

Background Image (set in Float template):

BlBackground Image
| Outer Image File E:\Program..|
Image position Scale to fit
Jinner Image File E:\Program..,
Image position Scale fo fit

The Float template enables you to add two background images: Outer Image and Inner Image.
You can make Inner background image to show special information, such as advertisement or
company logo, etc. There are also 11 kinds of "Image Position" for you to choose: Scale to fit, Fill,
Top Left, Top Center, Top Right, Middle Left, Middle Center, Middle Right, Bottom Left, Bottom
Center and Bottom Right.
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x. Flash Window Color

Flash Window Color

| W oxoo00 |

This color will be applied on all flash windows, such as the book window, "Help" window, "Print"
window and so on.

xi. Page Background Color

.....Page Badground Color

When load pages, or if the page number of your PDF file is odd, then the page (the last page) will
show with the "Page Background Color".

xii. Book Proportions

[ = Propartions |
Page Width i
Page Height

~=—\/\fidth—

|
Heightl wan.

Please note that the values are not fixed in pixels or inches, they represent a ratio of "Page Width:
Page Height", and the book size will be adjusted with your Explorer Window Size.

Copyright 2013 by FlipBuilder.com
-22-



e
r @; @ PDF to Professional Page-Flipping eBook Utility

User Document

xiii. Book Margins

Book Margin (set in Classical Template):

Book Margin | 50 |

"Book Margin" refers to the distance between the book and the toolbar.

Top/ Bottom/ Left/ Right Margin (set in Float/ Spread Template):

Top §

xiv. Page Shadow

 BlPage Shadow ;
Left page Shadow 50
Right page Shadow 25
Page Shadow Opacity  [0.5

Lefe page Shadow

Right page Shadow

The value also takes the value of Book Proportions as reference, and the value interval of "Page

Shadow Opacity" is "0~1", the larger value refers to the deeper shadow color.

xv. Hide Book Frame Bar

| Hide Book Frame Bar |'ves |

If don’t want to show the book frame bar, choose “Yes” in this option.
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xvi. Right to Left
If the language of your file is read from right to left (such as Arabic), then choose "Yes" in "Right
to Left" option:

| " Right To Left Jgsi

xvii. Start on Double Page
Open your book in double-page spread or not. "Yes" means open book without cover, presenting
first two pages at a time. If you have odd number pages, you can set this option as "Yes".

r
Hello:
] [= Welcome To g
/ l rF—I FlipPDF Demo '
ey it uilider oo

Start on Double Page N

Start on Double Page Yes

xviii. Hard Cover
If you want create hard cover effect (a book bound with rigid protective covers) for your flipbook,
choose "Yes" in "Hard Cover" option:

Hard Cover |Yeg

xix. Flipping time
Flipping Time [0.5

Sets page flipping time in seconds according to your needs. (Recommended value is 0.6)
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xx. Mouse Wheel to Turn page

Mouse Wheel to Turn Page fes

Enable or Disable turning page with mouse wheel.

xxi. Page Number

If you don't want to count in the cover page, table of contents pages into the actual page
numbers, you can set "Start Page Numbering (Roman)" and "Start Page Numbering (Arabic)". For
example, the first 3 pages are Table of Content pages with Roman page numbers, and set Arabic
page numbers from page 4, then you will get page number box like below:

EPage Mumber i
Start Page Mumber (Roman) |0
Start Page Mumber (Arabic) |3

Front Cover Page:

Pages: /8

The Fourth and Fifth Pages:
Pages:

xxii. Minime Style

If you want to present Page-flipping eBook pages directly without showing toolbar, especially
when you want to embed eBook into a small area in existing webpages, then you can use this
"Minime Style". The Minime Style will trigger when the Width or Height of the Flash Container is
less than the defined value. You can also always show the page-flipping eBook in Minime Style
with adding a parameter to your URL like this:

www.yourdomain.com/index.html?alwaysMinimeStyle=true .

Elminme Style

Use Minime Style Yes

Width 400
__Hoght 1300 |

(4). Flash Control Settings

EFlash Control Settings
Security Settings |Mo Security
HLinks
Google Analytics ID

i. Security Settings

| Security Settings Single Pass |
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If you want to protect your flash books with passwords, you can click "..." icon to enter into "Flash
Security Config" interface:

Mot
Srighe Pesgveord opbion mesns et usens need the passward o visw tee flash book

Exchude Front Pages option is to seta page number, all latter pages can't be
viswed without nputting passvwand.

Secunity Type
4 [ Security
I 1
—\\‘ @ Single Passwornd: 123458
Protect Fage Range
&) Pages |

& Exclude Front Fages 0

Lo ] [ co

Select "Security Type->Single Password", and input passwords into the box (there is no restriction

on password format at present). You can also set "Protect Page Range" as "All Pages" or the latter
pages after a defined page number. (Tips: The program utilize RC4 algorithm to protect eBook
pages, the eBook content pages will show nothing without permission.)

ii. Links

Bllinke
Mewsse aver color
Link alpha
Oprers Wirnthowe

Enable after zooming In |Enable

Create your professions! fipping book wilh POF fies

If you have check "Import links" option in "Import PDF" interface, or add links in "Edit Page"
interface, then you can define settings here, choose "Mouse over color", "Link alpha" (refers to
the link area opacity, value interval: 0~1, "0" stands for the area is totally transparent), and "Open
Window->Blank/ Self". The links also can be clicked after zooming by setting "Enable after
Zooming in->Enable".

iii. Google Analytics
In the HTML output format, you can add statistics by using google analytics. You can get more
information about Google Analytics ID from http://www.google.com/analytics/ .

Copyright 2013 by FlipBuilder.com
- 26 -


http://www.google.com/analytics/

(o o

TL

@ PDF to Professional Page-Flipping eBook Utility
User Document

2. Scenes Setting

To make your book more attractive and lively, you can apply animated background which
called "Scene" in the flip program. There are many pre-designed scenes for you to choose
and use directly, such as Autumn Leaves, Beach Beauty, Desert, Moon, Underwater World,
Grassland, Snow, Clouds, etc.

s lean
Maon
The coude The dandelon The sparidng Undersater warid
Fyrg [ Tty Tebared Lnaet
E s
e p— - L -
Seaw The douds0i The doudsl2 The diondisd

Just double-click to apply the scenes, or you can set your own style scene by settmg “SWF"
format background image in "Design Setting" part.

3. Bookmark Editing

You can check "Import Bookmarks" option in Import PDF interface if your PDF contains
bookmarks, or you can edit bookmarks directly in the program. In Classical Template, you
can even define bookmark font color, background color, position, etc.:

Design Setting | Bookmark | T

| ElBockmark |
Font color | I Onc000000
Background color [l SEAFF i
Badkground sipha |1
Always Show Bockmark | True
Panie Position Left

| Design Setting | Bockmerk |

mmw—*-n

Y '
lm:hnw
li'_l

Tite:  Other products

Page: &

4, Assistant

If you want to provide sound or text tips for pages of your books, you can enable the Assistant
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Feature, edit scrolling text, record audio or insert sound directly. Then readers can following your
tips, listen to the audio you applied, get more interest and info from your book.
— QM {EEE>HEAND 20O

B Recond BMansge Ao Fles  ||v
L P ) gt c "

Diuie chck 1o S00FF Ssainnt.

tare

w

o] . .
W FLISBUIL DER SOM | YouconfolowBetinio |
' OTAtE yOur UnGue anc

£ Thurrbnals © Auto Fip o) Sound On - Socsl Share i |

@ Record & Manage Audio Files

Click "Record & Manage Audio Files" icon to enter
into Record Audio interface:
Record Audio S|
| p 1 -
[[a] Page —  Audio text:
Lal Page 2-3 Hella, my name is Lily, Welcome to our Flip POF Professional demo project! The  «
LEI Page 45 wanderful Demao will show you rich features of this Professional software. You |
el can follow the tips to create your unigue and atiractive page flipping eBooks.
|'_T7.l| Page 6-7
| Lal Page 8-9
(| Page 10-11
() Page 1213 |- -
(4] Page 14-15 Audio:
La| Page 16-17 (@ Generate audio automatically (Text to Speech)
(@] Page 18-19 _
Engines: [Cepstral Allison "] | oh Generate sudio
(%] Page 20-21
La| Page 22-23 " Import audio from existing file
ERN 7
Play audio [0z 0] 0
L1 Page 25-27 ' Mics
1Y - LS i
About record sudio ’ Cption ] [ Apply ]

Input "Audio Text" for each page, and then choose Text-to-Speech engine, and then click
"Generate audio". After generating, you can click "Play audio" to listen to the audio, you can
also choose "Import audio from existing file" to apply existing audio directly.
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About Text-to-Speech engine install and use, you can view details in this page:
http://www.flipbuilder.com/support/how-to-read-your-text-to-readers-in-flipping-book.htm

5. Other Settings

(1). Export Theme

If you want to save the current template settings as your own style template for later uses, you
can click "File->Export current settings as Theme" button to storing all current template settings,
include the background images, margin values, toolbar buttons and so on.

Then when you want to use later, just click "File->Import Themes", the theme will be added to
the templates selecting interface. Download more themes from FlipBuilder now:
http://www.flipbuilder.com/templates-themes/index.html .

(2). Application Options

i. Render Engine Option

Flip PDF Pro provides 3 different render engines for you to create higher quality page-flipping
eBooks, click "Options->Application Options" to enter into "Render Engine" interface: SWF: Much
legible characters, smaller output size; GPL Ghostscript: Higher color transfer quality; Inner

Library: Faster convert speed (change option when PDF imported failed).
ii. Create Mobile Version Option

Pages Quality and Size
Five types of "Pages Quality And Size" for mobile version eBooks:

Pages Quality and Size

Quality And Size:  |Higher quality larger file size -

gher gua ge
High quality large file size
Medium quality medium file size
Low quality small file size
Lower quality smaller file size

High values [

LY but require i

Mobile Template
The current version provides two mobile template modes for you to use: Slide and Single Page
Flip. The later one adds page-flipping effect on the pages while viewing in mobiles.

.. . . ﬂ Apply Change .
After defining options, click icon to apply the settings.

IV. Edit Pages

(5] -
o Edit Pages
&

Use Flip PDF Pro to add link, video, sound or image file. Click "Edit Pages" button

to enter into page edit interface:
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Swi Properties

1. Add Link

Click the icon and then draw a link box on the area you want to add link, then define

properties in below panel:

Link Properties

© Down ® Up ® Move

® Over ® Cut
over color: [l Over Alpha:

Down Color: [l Down Alpha:
Normal Color: Normal Alpha: ® Gotopage ® Openalink ® Cal Javascript function

® Open Flash Window @ Play Audio ® Photo Slideshow

URL:

Link Target:

You can define the link action as "Go to page", or open an online webpage, or even "Call
Javascript function" to carry out your wanted interactive functionalities via defining Javascript
function yourself. For example, you can show a pop-up light box while readers clicking some
image on page, or pop-up a questionnaire or other Web Form by clicking some text. Just make
sure the parameter you set in "Function" can be called in from HTML page.
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Example: Check "Call Javascript function" as action type, then input Function as
"testLightBox("Hello, this is a test"):

® Down © Up M Move

Over B Out

) Go to page ™ Cpenalnk © Call Javascript function

Function:

And then make sure the Javascript wrote into the index.html page as below image shows (the

same as you set in "Link Function"):

<head>
<title>PDF-BenU brochure 2010-100dpi</title>
<meta http-equiv="Content-Iype™ content="text/html; charset=utf-8" />
<meta name="Keywords™ content="" />
<meta name="Description™ content="" />
<meta name="Generator™ content="[Flip PDF wversion 3.0] at http://flipbuilder.com/™ />

elim

<style type="text/css" media="screen">
html, bedy | height:100%; )
body [ margin:0; padding:0; overflow:auto; text-align:center;
background-color: #ELffff; |
g§flashContent | display:none; }
<fatyle>

<script <type="text/javascript™>

— g
1fumction testLightBodIstrFTomFlash]{
=

do the things you want here!
alert (strFromFlash) ;
}

<fscript>

2. Select Shape to Insert

You can draw shapes on pages as you want by clicking icon . You can add below shapes:
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(1). Line

Choose "Add Line" icon- to draw line on pages, and then define options for the inserted line

in right panel as you want. Like set Line Type as "Solid line" or "Dotted line", define Line Color,
Width, Alpha, Position, Size, Shadow, and Effect (support "Fade In" at present):

Line Properties o

= Solid line v

Line Color: Line Width: B

Line Alpha: B

Start X: Start ¥:

End X: End Y:

Shadow Options Effect Options

(2). Add Arrow-line

Click "Add Arrow-line" iconto draw arrow-line on pages. You can also define the arrow-line

proportions, like color, width, alpha, position, size, etc.:

Arrow-ine Properties x

CRE [ Solid line -

Line Color: Line Width: g
Line Alpha: B

LRGN Single Arrow v

Single Arrow

Start X:
Double Arrow

End X: End ¥:

Shadow Options Effect Options

(- o
N N

(3). Add Ellipse

Click "Add Ellipse" icon u to draw ellipse on pages, you can also define options like actions,

fill style, color, border, shadow, effect, etc. Action types include "Go to page", "Open a link", "Call
Javascript function", "Open Flash /video Window", "Play Audio" or "Photo Slideshow".
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8 2 G @ @ e
™ Over ® Out
Colorl: || Color2: ||
Angle: B Alpha:
Border Color: Border Width: ® Gotopage @ Openalink @ Call Javascript function
Border Alpha: ® Open Flash Window @ Play Audio ® Photo Slideshow
URL:

Shad Opfi Effect Optioi
ihbah Link Target: Blank

¥

(4). Add Rectangle

Click "Add Rectangle" icon nto draw rectangle on pages, you can also define options like

actions as "Go to page", "Open a link", "Call Javascript function", "Open Flash /video Window",

"Play Audio" or "Photo Slideshow". And define fill style, color, border, shadow, effect, etc:

Rectangle Properties

Action Options

tsvie: (RS O " ® e

Over ® Out
Colorl: B Color2: B

Angle: B Alpha:

Horder Color: Border Width: Go to page ™ Openalink @ Call Javascript function

Horder Alpa: g Open Flash Window @ Ply Audio ® Photo Slideshow

™ Round Rectangle i

Round Width: B Round Height: Link Target:
Shadow Options Effect Options

Lo oo |
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(5). Add Highlight Area

Click "Add Highlight Area" iconu to draw highlight on pages, you can also define options like

actions as "Go to page", "Open a link", "Call Javascript function", "Open Flash /video Window",
"Play Audio" or "Photo Slideshow". And define color, round rectangle, etc:

Highlight Area Properties

Action Options

D Down @ Up & Move
® Over ® Out

Color: . Alpha:

™ Round Rectangle

R AR H Round Height ® Goto page © Openalnk @ Call Javascpt function
ound vviden: o 2ight:

& Open Flash Window @& Py Audio ® Photo Sideshow

URL:

o]

3. Add Text

You can edit different types text by clicking icon:

(1). Add Plain Text

Click "Add Plain Text" to insert text into pages, then edit text content in right edit panel, you

can also define actions, font, color, background, effect, etc.

Text Properties

Action Options

| ) ® Move

i e
. (]

' Over ® out

Font Color: Font Size: B

™ Bold M ltakc

™ Fill the background
M Gotopage ™ Openalnk ® Call Javascript function
Background Color: .

. Window @ Play o o Sii W
Background Alpha: Open Flash Window Play Audio Photo Slideshow

Text: URL:

Link Target: Blank v

o] o
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(2). Add Callout

Add callout text like dialog box, just click "Add Callout" icon , input text and define actions:

Action Oplions

Font Color: ® Over ® Out

Flip PDF Pro s a much
piofessional prowram Lo
help you conwvart ordinary
PDF files into stunning
honklets with amazing
page flipping animations
) and sound! Besides wriginal
clacsical Fip PDF featuras
such as adding background
mages and sound, Hip PO
Pro ako provides more
powerful and professional

W Bold W Itaic

] Fill the background
: ® Go topage © Openalnk ® Call Javascript function

Background C .

f ® open Hash window @ Phy Audio @ Phoro Skide

Backoround Aloha: 8 G e - -

(1118
Horder Unlor: . Horder Alpha:

Link Target:
Bordar Width: B Blnk &

Comner Radius: |

o]
lexr:

(3). Add Animated Text
You can add text with different kinds of animated effect, such as Letter Spacing, Scale Word, Right

To Left, Center to Edges, etc. Just click "Add Text Anim" icon to add text and choose effect:

] = Anim Text Properties

Action Options

n

Font Color: Font Size: B

W Bold

Text:
© Down ® Up @ Move e

® Over ® out

® Gotopage € Openalnk @ Call Javascript function

® Open Fash Window ® Play Audio ® Photo Slideshow
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(4). Add Dynamic Text
To have your text scroll up a slide like the credits after films, just click "Add Dynamic Text" icon
to add text and choose action:

Dynamic Text Properties

=]

= T'his text has a vertical scroll - it starts 4

at the bottom and moves up. Font
onc -

Just input your text and *-r-_me text font Font Color: | Font see: g

L] i -

™ Boid M.

Action Options Bold W Halic
align: @ Left® Center® Right

Text:
© vown @ Up @ Move

& Over & out

17 Repeat ply text Scoll speed:
® Gotopage  Openalnk @ Cal Javascript function
® Open Flash Window @ Play Audic # Photo Slideshow

URL:

Link Target:

(5). Add Star Words Text

To make your text more different, you can click "Add Star Words Text" icon &to show text as

below shows:

Star Wars Text Proparties
Action Opiions

Font Color: [ Font Sie: B

=]

W Bold W Takc
aign: ® Left €3 Center® Right
@ Down @ Up @ Move Text:

® Over ® Out

] Repeat play text Sooll speed:

® Gotopage  Openalink @ cal
@ Open Flash Window @ Ply Audio to Shdeshow Stop

URL:

Copyright 2013 by FlipBuilder.com
-36 -



(o wor |
- - @ @ PDF to Professional Page-Flipping eBook Utility
' User Document

(6). Add Effect Text

To show text characters one after another, just click "Add Effect Text" icon E, input your text

and choose style, font and define actions:

Effect Text Properties

Acbivn Oplivns

* B

£ Mouse down ® Mouse up
M Mouse move M Mousa over

® Mouse out

® Gu Lu paye
@ Open 3 link & Cal Javasaipt function
® Open Fash Window ® Play Audio
@ Photo Slideshow
Foramt Properties
Foniz

Font Color
Font Sze B

W Bold ™ Ialic

4. Select Image Displayer to Insert
(1). Add Image

Click the icon E to draw image box and then select image (.jpg, .png, .bmp, .gif), set Action

Options (the same as Link Action Options), you can also set "Make it zoom when mouse over or
out" or "Add border when mouse over", and set Effect as "Fade In" or not:

® U Move
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(2). Add Embedded Slideshow

Click the icon "Add Embedded Slideshow" I_'ﬁb to show your images as slideshow. The images

are displayed one at a time and pan from one point to another. Suitable for photography

slideshow for wedding, presentation, etc.. :

Embedded Slideshow Properties

Select slideshow Image

Frame style

I

Image size

custom size n

a

"7 Repeat this slideshow

Slideshow property:

(3). Add Alpha Transition Banner

[
Show images as automatic slideshow resizable with alpha (transparency) transition effect,

you can also set shadow, image size and transparent value.

AlphaTranstionBanner Properties
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(4). Add Carousel Viewer

Add images to show in carousel viewerm, you can also set background color and border color.

CarouselViewer Properties

ct Images

Background Color

7 Add Background Color
Color: Alpha:
BackgroundBorder Color

7 Add Border Color

Color: Alpha:

(5). Add Clipart

You can add clipart on pages to decorate pages of your book by clicking "Add Clipart" Q and

there are multiple PNG format cliparts for you to add on pages directly, such as computer, animal,

dialogue, characters:

Clipart Properties

Select a Image

Action Options

Clipart Lib; el

animals
Til:l © D b | R CECEEREEEPCTRREPEELErn
------------------------------- O Mouse down ® Mouse up

® Mouse move ® Mouse over

M Mouse out

Mo Action ® Go to page
Open a link ® Call Javascript function
Open Flash Window © Play Audio

Photo Slideshow

Select a Audio File(MP3) [ TR
o]
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(6). Add Banner

Show images one by one with banner flipping effect, you can set actions for banner images.

*

Banner Propertios

e o

n

t function

(7). Add Dynamic Turn Photo

Show images in different rotation effectsE, you can set background color, border color for

photos.

Dynamic TurnPhoto Properties

Select TurnPhoto Images

Background Color

7 Add Background Color

Color: Alpha:

SackgroundBorder Color

™ add Border Color

Color: Alpha:

TurnPhoto property:

W:
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(8). Add Dynamic Show Photo

Show images in dynamic positions m, and you can set border of images.

]
Dynamic ShowPhoto Properties

Border Width

ShowPhoto property:

(9). Add Rotation Photo for 3D

Add 2 or more images to show with flash effectu, double click to flash play automatically,

one-click to stop, you can click "Arrow" buttons to change image.

Rotation PhotoFor2D Properties
Select Images

Background Color
IF] Add Background Color

Color: Alpha:

Border Color
7 Add Border Color
color: Alpha:

RotationPhotoFor3D property:

W:

5. Add Camera

Show details of an image like camera showm, you can add multiple layers to show different

details with frame move and stop effect.
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Font Color: [l Font Sze: a8
W Bold % makc

W Background fl

Background Color: Il

Background Alpha: a

Text:

"Blue Sea,'

«Blue Sky,
Blue Boat.

Add camera on some area of the image, then you can extract other area to show as second, third
layers. You can also add image, movie, text, shape, flash on images to show as you want.

6. Add Movie

Click icon H to choose movie player type, and then draw a box like below on the page you

want to insert FLV/F4V/MP4 movie. Then you can select and edit the movie in below panel
(define video player skin color, preview image, play and stop movie actions, etc.):

Select FLV Movie
M Blank
Player Skin: Bl

Player Skin Color:

CEVRULNER \When click play button

™ Replay when the re-enter the page

B U U= \When leave the page v

00:00/00:00 ™ show video time
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7. Add Sound

You can add different sound players by clicking icon "Select Sound Player to Insert". You can

choose Player Skin for all kinds of sound player, set skin color, when to play or stop the sound:

Sound Properties

: Select Sound
00:00/00:00 o a—

Skin Color:
=VELTLLE \When click Play button | »
SELTIGEE VWhen leave the page -

X W

b | song Name
e H:
| (O —— (0:00 /00:00
|

L L

® & &

8. Add Flash

Click icon E to insert SWF flash into your defined area of flipbook page, there are different

types of SWF files provided for you to use directly, such as tree, birds, cloud, butterfly, etc.:

Swf Properties

-]

Tin = Douhle cick to selact it
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9. Add Button

Click iconE to draw an area for inserting your image or SWF button file with calling actions.

The actions contain "Go to page", "Open a link", "Call Javascript function" and "Open Flash
Window". The before three actions are the same with the actions in "Add Link", the "Open Flash
Window" can help you to play SWF Flash or FLV Video in the pop-up window:

Button Properties Open Window Action Properties

Select an Icon(SWF,Image) Window Type: Open the window to play a video

Window Content: Salect The File

Window Caption:

™ Down @ . Mo
Down @ Up @ Move | yindow width: Window Height:

m Cancel

® Over ® Out

® Gotopage ® Openaink ® Call Javascript function

© Open Flash Window

m Cancel

10. Add You Tube Video

You
Click the icon and then draw a box on the page to insert You Tube video into pages directly.

You just need to define the video ID directly. For example the video link is:
http://www.youtube.com/watch?v=xKA6W!IqjB7c, then the video ID is "xKA6W!IqjB7c".

YouTube Video Properties

Video ID:

Video Parameters:

Play Movie: when click Play button

When dick Play button

Stop Movie:
When enter the page

When leave the page
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11. Add Printable Area
If you want readers can click on some area of your book to print the area directly, such as
coupons which can be used to buy your presented goods, you can add a "Printable Area" on

pages by clicking the icon E, and then draw the area on the pages, set title and description:

Link Properties

Color: B over Apha:

Border Color: Border Width:
Title:

Description:

12. Copy and Paste
If you want to add same links, images, videos, audios to different pages, you don't have to repeat
the "Link/Image/Video/Audio added" operations once and once again, just select the link object,

click the copy button and then go to the other page to click the paste button directly.

13. Apply All
If you want to use the same link, video, audio, image or button on all pages (or all odd, even
pages, or your customized pages), you can select the object and then click the Apply All button

"r! then define the apply page range in pop-up window like below:

Page Ranges

™ Al Pages ™ Odd Pages ® Ewven Pages

™ Custorn range:
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14. Add/ Delete/ Reorder Pages
If you want to add more pages to your existing project, or delete some page, or change the order
of pages, you can click the buttons on the left panel box to add (JPG, PNG or SWF), delete or

reorder:

GEGEG

Insert pages
(JPG, PNG, SWF supported)

FLiP PDF Pro

Delete the selected

Move Up

Move Down

Page Count: 8

After adding links, flash, movie or sounds, you can click the iconﬂ to save the

settings and back to the template setting interface.

V. Language Options Interface

Click "Option->Flash Language" or "..." button beside Language setting part, you will enter into

the Language Settings interface as below shows:
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»

ULnnguug:Scthrgs = 3 3 = =S
You can edit current language file or add a new language to desplay your page-fipping etiook, two or more languages can be
ispdd at the came time. Readers then can dick "Change | angiiage” huttan o view the eRank in their prefer language.
The fest dhecked larguaye on the top of the "Languages” st will be Laken as the defaull language to show your Tip buok. You
w can also define a language to the publshed fipping-book by speafying vath the address like:
hittoy: ffaraew, Jomain. com/mybook. htmi jex=48ang=
|| Louangues ]
] Erlish Qgiw:as 33 Load... | |:] Edit |
[ Chinese Language Sellings
[ Arabic
[ French Label | Labeled -
Fesl Bullon First
[] German Next Pace Button Next Page
[ Greek Last Button Last s
Previous Page Button Previous Page
[ tebrew Downioad Button Download
[ Itakan Print Button Print
Search Button search
[] 3apanese Book Mark Button Book Mark
[] Fortugues Help Button Help
Enable Fuliscreen Button Enable Fullscreen
Disable FullScreen Button Disable FullScreen
Sound On Button Sound On
Sound Off Button Sound Off
Share Rutton Share
Sodal Share Button Sodal Share
£oom Ln Button Zoom In
Zoom Cut Rution Toom Dut
| Auto Flip Button Auto Flip b
¢ X € &
oK

Panel Description:

As the tips explaining, the "Labeled" column lists the buttons and instructions on Flash books in

defined language, and the program provides you 10 different languages for you to use: English,

Chinese, Arabic, French, German, Greek, Hebrew, Italian, Japanese and Portuguese.

You can

also add other language for your own uses:

1. Click the button ; % and define name for the new language:

'El MNew Language

o

hew Language |

Name: Frendh

Copy From: [Englsh

a

2. Choose the first label and click "Edit" icon, define new language text in "Labeled" box, then
click "Save And Edit Next":
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Hext Page Button

Last Button Last i Edti Language ltem

Prévious Page Button Prévius P m——————

Dowvrdoad Button Devarioad Eengunge: Sing

Print Button Print

Saarch Buttsn search Lebel:  FstButton

Eaok Mark Button Baak Mark 2 .
Help Buttan Help (beled;  Presmibre|

Enable FulScoreen Button Enabls Fulls

Draabls FullSoresn Button Disahle Fult!

| B i Bisbbm

Epaamd P N

[ Save And Edit Next ] '

oK

3. At last, you can get all Labels translated into your new language as the images shows:

Label Labled

First Button Premiére

Mext Page Button Page suivante
Last Button Derniére

Previous Page Button Page précédente
Download Button Telecharger

Print Button Imprimer

Search Button Rechercher

Book Mark Button Réservez Mark
Help Button Aide

Enable FullScreen Button Activer FullScreen
Disable Fullscreen Button Désactiver FullScreen
S i B abee = Criomd

W Delete
You can delete unwanted language:

Or save your edited new language file as XML or TXT file:

Load language file saving before for current using:

ﬂ Apply Change

After setting language, click icon to apply settings.

VI. Upload Online

To make it easier for you to publish your created flip page books online, we developed the
Upload Online Service. By using this service, you can upload your book online instantly after
creating it, with no FTP or other upload tool needed. You can easily manage your books, and
make it easy for people to view your books online in their browser on their PC, Mac, iPhone, iPad
and Android devices.

sl upload online
After designing your book style, just click "Upload Online" button | - .. to upload

your book onto FlipBuilder website server directly. Just need 3 steps: Sign up, login your account,
upload your book.
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1. Sign Up
Create your account to use the Upload Service easily:
Login g S|

Sign up and start sharing your flip books online
(@) Create new account

Email:

Password:

(7 Use an existing account

Create || Cancel

2. Login Account
After registration successful, you will login automatically.

3. Upload Your Book
After login your account, just input your book HTML title and then click "Publish Now" to
upload your book. You can also define Description and create mobile version in "More":

[ Upload the book ESIIOE <]

Book sattings. | f

HTHL Meta Sethings ‘
Tite: FineoF

Desaipon:  conyert pdf to page-fipping ebooks to publich oniine eastly, with background mage,
‘sound, book thidaess chect odded

7] it Maakee Mot Versinn, Pl ser {a Lemplate for mobsle: | S P P | ‘

7| Override an existed book:

!E!Mm Cancel : |

After uploading successfully, you can use the Book URL to share with others online, or
through social share websites, or copy the Embed Code to insert into webpages in "Book
Information" panel, etc.

i Upload Successhul LX)

Book URL: http:/ / t.flipbuilder.com/Ibse / cycw

’ Copy ] | View Now ]

" Send email | «<; Social share | () Insert to site|

Send to
{For example: guest1@Gmall. com;quest2@Gmai. com) E]

From Subject
(For exampie: your name or company,) (Vo subject)

Message |
(vour commenis) -

’ Manage my books ] i oK I
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e Manage Online Books|

bl
You can click "Manage Online Books" button ' lin main process

interface to manage your uploaded in below window:

E My Publications
&5 Public Sharing

= ;
(&) Protected Sharing Title Pages Size Create Time State

;’1 My CoBections " Uemolew ‘ )
L Pages:28 | Size:36.6M 2012-11-06 15:07:33 Startup PR
tp://t. fipbuilder .com/Ibse foyon

| ched Al | i 8 oo - {{ nefrosh Boakiist

Points: 5 Purchase  One point can be used to enable a book to FlipBuilder Server in one month
Total books: 1 Select1/1
Used Disk Space:

In the book manage window, you can check your publications, share them with others, edit
book info, hide your book to prevent other people from reading your book, even delete it if
you want to edit again.

You will get 5 free points after registering, and a point can be used to upload a book within a
month. You can purchase more points to use based on your needs, and more points
purchase at a time, you can get order with more discount.

Within 24 hours of the first start service for each book will not charge, and a point will be
deducted after the 24 hours. If you delete or disable the book within the month, the service
center will stop charging you in later months, or if you enable the book again in the same
month, you won't be charged again. Should be noted that, if you disable the books within
the first 24 hours, the system won't charge, but if you enable the books in the period after
this 24 hours, the system will immediately charge points. And once your surplus points are
not enough to pay for all books service, the system will enable related number of books, but
disabled the other ones.

There is another charge method if you have dozens of even hundreds of books to upload a
month, monthly charge $9.99 to upload 1000 books a month. You can transfer to VIP User to
pay monthly in the "Account Info" panel of online manage page:
http://panel.flipbuilder.com/userLoad/accountinfo.php .

More FAQs about Upload Service: http://panel.flipbuilder.com/userLoad/fag.php
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VIl. BookCase

BookCase integrated in Flip PDF Pro will be the best tool to help you build digital
library to store and manage eBooks. All books you published on FlipBuilder Server or
some other place online can be collected and shown in your bookcase, you can easy

manage and share the books via using the wonderful and realistic BookCase tool.
B et b -t besinO T A TER. EERST N casos

More details about how to use and design BookCase here:
http://www.flipbuilder.com/bookcase/manual/index.html

VIIIl. Output Interface

Click "Convert to Flipping Book" to enter into output interface:

E Output Option E

Cutput |
Output type

@

Alzo Make Mobile Version  Make output page-flipping eBook works on iPad, iPhone and Android mobile devices

Path
Output Folder: C:\Wsers\Administrator\Desktop'fiipbook [ Browse... ] [ Qpen ]
File Mame: index it
COptions
HTML Title: demo ) @ Advanced
[FBurn to cD

CD Wiriter D 1:0,G: PLDS  DVD-ROM DH-16D55 VD15 >

[[IMake it automatically play the fipbook in CD

I— Cancel I ’ LConvert
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There are below Output types you can choose:

1. HTML

A :
Qﬁ’ @ =himi

This output type is for uploading created page-flipping ebook onto websites:

You can define HTML Title and other properties by clicking "Advanced" button:

Options

HTML Title: demo {4 Advanced

Set Keywords, Description or even Script in the below interface:
EJ Advanced Settings ﬁ

HTML Advanced Settings i
HTML Meta Settings
Title: demo

Keywords:  pdf, flipbook, page-fipping, ebook, online, website, flash, background, music

Description:  This page-fipping eBook shows you the stunning flash effect on FOF pages, a

Add Scripts
You can put some tracking
odle such as Google
Analytics here,
Need dosed <saipt=>tag!
ox [ concel

@ *.zp

This output type is for compressing the created files into an integral ZIP package which can be
sending out as attachment directly. You can also define HTML Advanced Settings by clicking

Your recipients just need to uncompress the ZIP file and then they can view the HTML flipbook

instantly:
. files
\B dermna.html
book.swf
Uncompress
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3. EXE

G o e

This type is for outputting flipbook as a single executive file, easy storing and easy viewing. You

can also define Icon and Opening Window Size in Advanced Settings:
hj Advanced Settings -

Cxe Advenced Seténgs
Exe Window Info

Cgption:  demo
Icon: T [ [ fad |
Izon: - 7 I Defauds

Window Size Opbon
Mawmized Custom Size

@ Full Soreen

If you want to make executable application to run on Mac devices, output as "*.app" format.

5. Mobile Version

[¥] also Make Mobile Version
You can even output Mobile Version while choosing HTML or ZIP format at the same time.
After creating mobile versions, you just need to output all files online (including HTML, SWF,

"files" and "mobile" folders), then you can visit the flipbook page through your mobile browser.

6. Burn to CD

[#] Burn to €D

CD Wiriter |D: 1:0,G: PLDS DVD-ROM DH-16D55 VD15 ~

Disc title: Page-Flipping eBook
[¥] Make it automatically play the fipbook in CD

After choosing output type, check the option "Burn to CD", set "CD Writer", define "Disc title".

How to make created eBooks available for others online, more details this support page:
http://flipbuilder.com/support/how-can-i-share-my-created-ebook-online.htm .

At last click button to output flipbook in your defined type.
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IX. Batch Convert Interface

Click "Convert->Batch Convert" to enter into batch process interface:

[g] Batch Convert

i

1 Add PDF Documents

” . AddFies || Add Eclder femove I3 Clear Al N Movelo (55 MoyaDa
Name Path
)_-ka Printer E:Useful Documents\POFs {Fip Printer, pdf
|A=Flip PDF E:\Useful Documents\POFs \Flip PDF.pdf
| A=Flip Word E:\Useful Documents\POFs \Flip Word. pdf
|AFlip PPT E:\Useful Documents \POFs\Flip PPT.pdf
) Settings
Output Settings | PRF Setings
Ouiput type

::3' © <himl \%ﬂ =2 {gﬁ.! O e “’ O

[¥] Also Make Mohile Version  Make output page-flipping eBook works on iPad, iPhone and Android mobile devices
Path

QOutput Folder: C: .K.Esers \A.c.l.minxsh'ahué \,Desktup \ﬂxptnok

File Name: {PDF FileName} w .himl | File Name pattern:
Result
Fiip Printer
Opslivr s
HTML Title: My FlipBook o ‘rﬁ A
My FlipBook

[FiMerge All PIF Fdes tn One FlinRonk

£} Convert to Flash

1. Add PDF Documents
s dd Files '

Click this icon to add PDF files from computer;

I { dd older.
‘ﬁ‘ Click this icon to add all PDF files in the folder (include sub-folders).

You can also remove some unwanted PDF, move up/ down files, or clear all documents.

x Remove & Clear All @ Move Up @ Maove Down

2. Settings
(1). Output Settings

i. Choose Output Type

Output type

P -

Also Make Mobile Version  Make output page-flipping eBook works on iPad, iPhone and Android mobile devices
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ii. Choose Output Path

Path

Cutput Folder: C:\Users\AdministratoriDesktop Browse... H Open ]

You can also define output name pattern with FileName, Title, Subject and so on:

File Name: |~

{PDF Title}
{PDF Subject}

EiDF .ﬁ.uﬂmri
PDF FileMName}

And after defining the File Name, you can preview the result example below:

File Mame: {PCF FileMame} Flipping Book -

Flip PDF Flipping Book

iii. Define Output Option

Options

Caption:  {PDF FileName} - {-il Advanced

Flip POF

Click "Advanced" icon to define Keywords, Description for HTML flipbooks, or define Icon,
Window Size for EXE flipbooks:

.J Advanced Settings ﬁ .] Advanced Settings EH
HTML Advaraed Seitngs | [[exe Advanced setongs | ]
HTML Mata Settngs Exe Window Info
Tte: demg Capton:  demo
Keymords:  pdf, fiobook, page-fiopng, ebook, onling, website, flash, background, music )
Descripton: Mhis page-fipoing eBock shows you the stunning flash effect on POF pages, <0 | | Re ]
Add Soipls Windew Size Spben
Yiou can put some tradking Mawmized Cystam Sipe
mﬂ; such as Google
s here.
Meed Sapttay @ Ful Soeen
| -
e [ o [ gu

iv. Merge All PDF Files to One Flip Book
If you want to output a single flipbook with imported multiple PDF files, you can check the option:

[¥]#erge All FOF Files to One FlipBook:
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(2). PDF Settings

i. Page Range
The Page Ranges to Import
) All pages

P25 Example: 1,9-21,30

You can convert "All pages" or just "Custom range";

ii. Watermark
Watermark
L7 Place a custom text or image
‘ Watermark({Stamp) to the file(s)
4

Click "Set Watermark" icon to enter into "Watermark" interface, check "Applying Watermark"

option, and then you can choose default stamps, Edit them, or Add Text Watermark, Add Image

Watermark, Delete, Move Down/ Up.

iii. Page Quality

High guality large file size -

] i o B
Medium guality medium file size
Low quality small file size
Lower guality smaller file size

Choose quality and size type from listed five kinds.

iv. Other Options

[7] Impart bookmark
page-flipping eBook;

Impaort links

[¥] Enable search

Bk
Convert to Flash
Fur

At last, click
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X. Use Flip PDF Pro in Command Line

You can also use Flip PDF Pro in Command Line.

Flip PDF Professional Command Line Usage:

PTCMD.exe [Options]
-f<PDF File>
-o<output folder>
-t[html|zip | exe]
-n<OutputFileName>
-c<caption>

-s<Flash settings>

-r<page range>.

-gq<import quality>

-R<GS|SWF|LIB>

engine)

-b<Y|N>

-I<Y|N>

-S<Y|N>

The source PDF file.

Specify the folder for the output files.

Output type. Default is html.

Specify the name for the output file.

Caption for HTML or EXE.

Value format is:<Template name>#[<Theme name>|
<txt_settingfile path>].

<Template name> could be: Classic, Float, Spread.
<Theme name> are list in the "Select a template" window,
such as Blank,Blues,Nostalgia.

<txt_settingfile path> is the file that you export

with "Save the template settings" function

The page range that you want to import from PDF File.
Range value string like:2-15,33,35-36,0r All.(Default: All)

Count be 5,4,3,2,1.5 specify the higher quality larger file
size;1 specifies lower quality smaller file size.(default:4)

Render engine options. (Default: GS, Ghostscript render

Import bookmark yes or no. (Default: Y)
Import links yes or no. (Default: Y).

Enable searchable or not.(Default: Y, enable searchable)
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-k<html key words> Set the keywords for html output file.
-d<html description>  Set the descriptions for html output file.
-j<html javascript> Set the javascript for html output file.
-i<icon file path> Specify the icon path for exe output.
-w<window size> Specify the size of exe window.

Value could be: M,F, or some string like:800,600.
(width is 800,height is 600).

Examples 1:
PTCMD -f"C:\input.pdf" -0"C:\outputfolder" -n"index" -thtml -c"Title"
-s"Float#c:\my_ebooksetting.txt" -r"1-8,9-14,42" -q4 -R"SWF" -bN

Examples 2:
PTCMD -f"C:\input.pdf" -0"C:\outputfolder" -n"ExeFileName" -texe -i"C:\app.ico"
-c"Title" -s"Float#Blues" -r"All" -g5 -R"GS"

Examples 3:

PTCMD -f"C:\input.pdf" -0"C:\outputfolder" -n"index" -tzip -c"Title"
-s"Float#Blank" -r"All" -5 -R"GS" -k"html key words"\

Return Code:

Success

Input file not found

Parameters are invalid

Failed to load PDF

Failed to import bookmarks

Failed to import links

Failed to import searchable information
Failed to save the output file.

N HREWNR
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License Agreements

All copyrights to Flip PDF Pro (the Software) are exclusively owned by FlipBuilder.com. For
more information, visit our website at www.Flipbuilder.com .

Anyone may use this software but all the page-flipping eBooks generated will automatically
have a demo watermark on the first page of them. To remove the limitation you must
register.

Once registered, the user is granted a non-exclusive license to use the Software on one
computer (i.e. a single CPU) at a time. The registered Software may not be rented or leased,
but may be permanently transferred, if the person receiving it agrees to terms of this
license.

The Software unregistered (trial) version may be freely distributed, provided the distribution
package is not modified. No person or company may charge a fee for the distribution of the
Software without written permission from the copyright holder.

THE SOFTWARE IS DISTRIBUTED "AS IS". NO WARRANTY OF ANY KIND IS EXPRESSED OR
IMPLIED. YOU USE AT YOUR OWN RISK. THE AUTHOR WILL NOT BE LIABLE FOR DATA LOSS,
DAMAGES, LOSS OF PROFITS OR ANY OTHER KIND OF LOSS WHILE USING OR MISUSING THIS
SOFTWARE.

You may not use, copy, emulate, clone, rent, lease, sell, modify, decompile, disassemble,
otherwise reverse engineer, or transfer the licensed Software, or any subset of the licensed
Software, except as provided for in this agreement. Any such unauthorized use shall result in
immediate and automatic termination of this license and may result in criminal and/or civil
prosecution.

All rights not expressly granted here are reserved by A-PDF Solution.

Installing and using the Software signifies acceptance of these terms and conditions of the
license.

If you do not agree with the terms of this license you must remove the Software files from
your storage devices and cease to use the product.
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How to Order

Order Online (http://www.flipbuilder.com/flip-pdf-pro/index.html) or Order Toll Free

1-877-353-7297 (When you order toll free just give the operator the product number of the
product you would like).

How to purchase online?

1. Select a license type above, and click [Buy Now]

2. Select the currency that you want to use. (You can also continue shopping)

3. Fill billing information and select a payment method. (Your information is safe with us)
4. Check the information you filled previously and click "Place Secure Order"

Other Order Ways—With Phone/Mail/Fax/Check:

If you are not comfortable ordering online witha credit card, you are welcome to choose an
offline order option in the payment section of the order process. We accept mail, fax, wire,
and PO (if applicable) ordering options in addition to ordering online. We also provide
phone orders through our 24x7 order desk at 1-877-353-7297, or (952) 646-5331 for
International Callers.

Please note that all of the offline ordering options do have additional fees for processing. To
place an order by mail, fax, wire, and PO (when applicable), use the online form and then
choose one of these payment options found in the Payment Method section of the form.
Once submitted online, the appropriate information will be provided to you in your web
browser to send your payment to us offline.

100% unconditional 30 Day Money Back Guarantee

Want to custom the program or have other questions about purchase?
Contact us at alice@flipbuilder.com .
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Support

You can easily search or browse our frequently asked questions, and learn tutorials about
products, and get your registration code back. If you are not satisfy with the solutions
provided, please contact support team for help.

1. Frequently Asked Questions

You can find answers to questions about technique issues here:
http://www.flipbuilder.com/support/list-Flip-PDF-pro

2. Learn tutorial about Flip PDF Pro

We publish a video tutorial which shows you the easy procedure of dealing with Flip PDF Pro,
you can view this video to quickly handle the stunning tool: http://youtu.be/ pTFcUVo7Zw

3. Get lost license code

Click here to look up the order » (http://www.regnow.com/cs/orderStatus)

You can pull up a copy of your order by entering your email address. After you find your
order, you may view its status, view details of your order (including the license key), and
obtain the invoice.

4. Contact Us

If you have other questions or requirements, contact us directly through our support Email:
alice@flipbuilder.com, we will respond you ASAP.
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